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Chapter 1

Introduction

The concept of scanning and the interaction between Scan
Station and the printer. How to get information from paper
to file.
5



This manual has been written for ...
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This manual has been written for PC users of the Océ Scan Station applic
for Microsoft Windows. Knowledge of Microsoft Windows basics is
presumed.
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An Océ large format print system will primarily be used in central
reproduction environments. Remote control, speed and integrated finishin
capabilities make the Océ printer the ideal solution in these environments
Files that are sent to the printer will be printed, sorted and folded on requ
This results in greatly improved productivity over traditional printing and
copying.

Combined with a special software application, the Océ print system allows 
to productively scan paper drawings and convert them to digital files.

Prints, hard copy drawings and print files are not the only form of informat
entering repro departments. Equally important is information regarding:

■ how copies should be produced,
■ how sets should be printed ready for distribution,
■ how prints are to be distributed.

This type of additional information is traditionally communicated via
telephone, fax, or internal electronic mail. Rather than improving just part
the reproduction process, the Océ scanning and printing applications incl
all these information aspects.

Océ scanning and printing applications

The Océ scanning and printing applications support the digitalisation of
engineering drawings, and/or the high-volume reproduction of digital
engineering drawings. These applications are supplied by five software
modules:

■ Job Director
■ Repro Station
■ Scan Station (described in this manual)
■ View Station
■ Machine Monitor

Job Director Job Director is a Microsoft Windows application which runs o
PCs, ideally in a network. It allows users to create, edit and send reproduc
requests - jobtickets or matrix tickets - from any PC to Repro Station.



For more information, see the Océ Job Director User Manual.

Repro Station Repro Station is a Microsoft Windows application which
controls printing on the Océ printer. All print jobs go through Repro Station
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where they are queued, logged and managed. Repro Station supports th
following functions:
■ accept plain print files, print files with Océ header information and digita

reproduction requests (job tickets),
■ provide queuing and other system management functions to the operat

the printer,
■ control the Océ printer to produce complete sets of documents: sorted, fo

and deposited in one of the output devices of the printer, ready for
distribution.

Apart from job requests initiated by Job Director, Repro Station also acce
print jobs and check plots from other sources, like printer drivers or docum
management systems. Job tickets must comply with the job ticket format
specification as described in the ‘Océ Job Ticket Interface Programmer's
Manual’.

For more information, see the Océ Repro Station User Manual.

Scan Station Scan Station is a Microsoft Windows application which allow
you to control the scanning (also called upload) process. You can specify
settings like resolution and file format. You also specify where the resultin
files must be stored, which can be a network disk. When a file has been
received by Scan Station you may view it on the PC's screen to check the
quality of the scan.

This manual describes Scan Station in more detail.

View Station View Station is a built-in viewer that allows you to view scans
made with Scan Station on the Scan Station screen.

For more information, see the Océ View Station User Manual.

Machine Monitor Machine Monitor is in fact part of the Repro Station and/o
Scan Station concept. Repro Station and Scan station can send scan jobs
printer via Machine Monitor. If both Repro Station and Scan Station want
send a job, Machine Monitor decides which job comes first, and which job 
to wait.



If the printer supports back channel communication, Machine Monitor can
also collect information from the printer, and send this information to Repro
Station or Scan Station. In this way the following information can be collected:

é
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■ Status information
■ Printer settings, e.g. engine configuration, printer stamps
■ Other printer information, e.g. printer in error
■ Rolls and media information
■ Job information (statistics)

For more information, see the Océ Machine Monitor User Manual.

The illustration on the next page gives you a complete overview of the Oc
scanning and printing concept.



.
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[1] Océ scanning and printing concept
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This manual is intended for the operator of Scan Station. The user of Sca
Station is often also the operator of the Océ printer/copier. It is assumed 
you have some understanding of the Océ printer. More information can b
found in the User Manual.

This manual explains:
■ how to install Scan Station and how to get things up and running (Chapt
■ how to use Scan Station to scan files (Chapter 3)

Read Chapter 2 for a brief introduction and learn how to install and get th
program running on your PC.

If you want to have a thorough understanding of the functions of Scan Sta
you should read Chapter 3.

Related documentation

Océ 9800 Copier Printer User Manual
Océ 9800 Printer User Manual
Océ 9700 Copier Printer User Manual
Océ 9700 Printer User Manual
Océ Job Director User Manual
Océ View Station User Manual
Océ Repro Station User Manual
Océ Machine Monitor User Manual
Océ Remote Control Format Reference Manual
Océ Job Ticket Interface Programmer’s Manual
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Getting started

How to install the software on your Windows PC. What
preparations are required before you can actually use it.
13
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The recommended hardware for Scan Station is:
■ a PC with Pentium 100 MHz Intel processor, running Windows 95 or

Windows NT 3.51/4.0 for the 32-bit application or Windows 3.1/3.11 for th
16-bit application.

■ internal memory of 32 MByte.
■ a dongle for Océ View Station, used by Scan Station (the dongle is delive

with Océ View Station).
■ a TCP-IP network (needed for remote connections).
■ sufficient disk space to save the scan files.

During installation of Scan Station several files will be copied to the hard d
of your PC. The installation program prompts you to create the destinatio
directory in which the files are copied.

When installing Scan Station, you can press the Help button for more
information about the steps. To return to a previous step, click Back.

Note: Install Océ View Station before installing Scan Station.

Machine Monitor Note that during the installation of Scan Station you are
asked whether also Machine Monitor must be installed on your PC. This
depends on your configuration:

■ It is possible to run Scan Station and Machine Monitor on different PC’s
Machine Monitor must always run on the PC that is directly coupled to t
printer with a SCSI connection. Scan Station may run on a different PC, 
remotely couple to Machine Monitor via a network. In that case selectnot to
install Machine Monitor as well. Machine Monitor must be installed
separately on the other PC (see the ‘Océ Machine Monitor User Manual
more information).

■ In the recommended configuration, Scan Station and Machine monitor 
on the same PC. This PC is directly coupled to the printer with a SCSI
connection. In that case select Machine Monitor to be installed as well. M
sure to install the SCSI connection to the printer first:

▼ Installing the SCSI connection

1 Install the Adaptec SCSI board on the PC.



2 Install the EZ-SCSI software.
3 Connect the Océ 9700/9800 and make sure that it is recognized as ‘Tandberg

TDC 3600’.
Getting started 15

▼ Installing Scan Station software

1 Insert the CD ROM into the CD ROM drive.
2 Now follow the instructions in the CD ROM’s booklet.



Starting Scan Station
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You can start Scan Station in several ways, just like any other Windows
program. Follow the procedure below. Quitting Océ Scan Station is explai
in ‘Quitting Scan Station’ on page 28.

Note: If you are using Scan Tickets, Scan Station can be started up
automatically by a separate software application (see ‘Using Scan Tickets
page 57).

▼ To start Scan Station

1 Start MS-Windows.
2 Double-click the Scan Station-icon in the program group you just created

The Scan Station main window will be displayed as shown in the illustrati
below:

[2] Scan Station main window

3000-144



The very first time you start Scan Station:
1 You must enter your name and the name of your company. This will be

displayed on the start up screen.
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2 You will be asked to specify the location (directory and filename) of Océ Vi
Station. If you have not yet installed Océ View Station, select Cancel and
install View Station first:
■ Select Use viewer in the Preferences (see ‘Defining Preferences’ on

page 22).
■ Exit Scan Station
■ Install Océ View Station
■ Start Scan Station
■ Specify the location of Océ View Station

Note: Alternatively, you can define the preferences in a way which enables
to install Océ View Station after you have installed Océ Scan Station.

3 You are asked to specify whether Scan Station has to connect to a remot
Machine Monitor application or to a local Machine Monitor. If the printer is
coupled to this PC, choose Local.
If the printer is coupled to another PC which runs Machine Monitor, choos
Remote and enter the name of the PC and network ID.

When the viewer has been enabled (see ‘Defining Preferences’ on page
and Scan Station starts up, the viewer is automatically started.

When a local Machine Monitor has been selected (see ‘Configuring netwo
on page 18), also the Machine Monitor is started automatically. Machine
Monitor will appear in the state that you have specified: either as an icon 
window on your desktop.

If you have selected a remote connection, Scan Station will try to connec
Machine Monitor across the network.

Note: The first time you start Scan Station, it creates an initialization file
named ocestf98.ini in the directory in which the software is installed. This 
contains your default settings.



Preparations
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Before you can work with Scan Station, you need to define several settings
default values. The following sections explain how to modify these setting
match your configuration or personal wishes.

Machine Monitor

Machine Monitor is the application that provides the connection to the prin
You need to make some settings in Machine Monitor first, like printer type
language, and network settings. Refer to the Machine Monitor User Manu
for details.

Configuring network

To receive data from the scanner, Scan Station must connect to Machine
Monitor. Machine Monitor can run on the same PC (local), or on a network
(remote). You have to specify if Machine Monitor runs local or remote.

Note: If Machine Monitor runs remote, the PC’s must be running Windows N
and be connected via a TCP/IP network. Scan Station will use a TCP/IP so
connection to send data to Machine Monitor. Scan Station can only make
connection when Machine Monitor is already running on the remote PC.

▼ Configuring Network

1 From the Configure menu, choose Network.
The Network dialog box appears.

[3] Network dialog box

3001-144



2 Select Local or Remote.
If you select Remote, also define the IP adress of the remote PC (Host) and the
Port number (Port).

s

 help
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Note: The port number must match the Scan port number in Machine
Monitor. Normally you can use the port number that is already filled in.

3 Click the Connect button.
Note: Machine Monitor must already be running. If Machine Monitor start
later, you must repeat this procedure.

Setting the interface language

You can set the language of Scan Station menus, dialog boxes and on-line
as follows:

▼ Setting the interface language

1 From the Configure menu, choose Language.
The following dialog box appears:

[4] Language window

2 Open the drop-down list box and select the appropriate language.
3 Click the ‘OK’ button.

The working language of Scan Station will be changed.

3002-144



Defining a list of users and accounts

You can define a list of users and accounts, e.g. departments, to allow print job
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management. This list is used for the following purposes:

■ Statistics
In the list a number is assigned to each user and account. This number is
for statistical purposes (job logging) by Machine Monitor.

■ Print permission
In Repro Station you can restrict printing. If this option is selected, only us
and/or accounts that are defined in the list are allowed to send jobs to t
printer.

■ Bin selection High Capacity Stacker
In Repro Station you can define which output bin is to be used. This isnot
possible in Scan Station.

■ Assigning user and account names to Scan Station jobs.
In Scan Station you can select user and account names from the list to a
to scan jobs and check plots (see ‘Job settings’ on page 37).

You can define a list of users and accounts in Repro Station, Machine Mon
and Scan Station. If the applications are installed correctly, onlyone list of
users and accounts is used. You can use any of the named applications t
users and accounts to this list, or to remove them.

Attention: Only if Machine Monitor and Scan Station are installed on the
same PC and in the same directory, the named applications will use th
same list: the ASCII file ‘accounts.txt’. If installed on different PC’s, afte
changing the list you must copy the file ‘accounts.txt’ in the directory
‘Accounts’ (one directory higher than the directory where the Océ softwa
resides) to the same place on the PC where the software of the other na
application resides.



▼ Adding Users and accounts to the list

1 From the Configure menu, choose ‘Users and accounts’.
The Users and Accounts dialog box appears.
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[5] Users and accounts dialog box

2 In the Name box of the Users and/or Accounts, type the respective name o
user or account user you wish to define.
For example, an account name could be the name of a department: ‘Sale

3 In the Number box, type the number you wish to assign to the user or acc
(you can enter up to 9 digits). If you click the button that is located at the ri
side of the number field, the first free number (following the currently
displayed number) will appear. This number is not in use for other users o
accounts.

4 Choose the Add button.
5 Repeat steps 2 to 4 to add all the users and accounts of your choice.
6 Click the OK button.

▼ Removing Users and accounts from the list

1 From the Configure menu, choose ‘Users and accounts’.
The Users and Accounts dialog box appears (see figure 5).

2 Click the button behind the Name box of the Users and/or Accounts to se
a user or account you want to remove from the list.

3 Click the appropriate ‘Delete’ button to remove the selected user or acco
from the list.

4 If you want to remove all users or all accounts from the list, click the
appropriate ‘Delete all’ button.

5 Click the OK button.

3003-144



Defining Preferences

The Preferences dialog box is used to:
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■ specify scan history length
■ specify scanned files units
■ specify original size units
■ specify filename extension for TIFF and CALS
■ select if incoming scans must be viewed.

[6] Preferences dialog box

▼ To specify preferred settings

1 In the Scan history box, type the maximum number of files that are visible
can be scrolled into view) in the Scanned files list of the main window. Th
setting does not affect the number of scans that can be made in a job, on
number that is shown.

2 In the Scanned files box, define the unit that is used in the main window, 
show the length and width of the scanned file. Choose mm, inches or pix

3 The settings in the Original size units box are not used and can be ignore
4 Specify which default extension will be used for CALS or TIFF files. For

example: If you type TG4 in the TIFF extension, all scanned files in TIFF

3004-144



format will get the filename <name>.tg4. This only happens if you did not
specify a specific extension elsewhere (see ‘Job settings’ on page 37).

5 Specify the time after which Scan Station will automatically disconnect if no
utes.
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data is received from the Océ 9700/9800. Default this time is set to 13 min
6 Only select Use viewer when you want the Océ View Station to start

automatically when Scan Station is started and display all incoming scan
Deselect Use viewer when you do not want to examine all the scanned fi
Note: You can always view a file by selecting it from the list and clicking
the View button. It is also possible to double click the file (only when
Double click on file name in the Tools window is checked). (see page

7 Click OK to save your Preferences or Cancel to discard the changes. The
Preference settings are active for all scan jobs.

Tools

You can start other applications without leaving Scan Station. This allows 
to for instance view, or convert images after they are scanned. These
applications are called Tools in Scan Station and they are listed in the To
menu.

The Tools menu lists either applications, or groups of applications. For
instance: Viewers, Convert, Access. Where Viewers is a group of viewers,
Convert and Access are applications.

Applications can be associated with certain types of files through their
extension, for instance Viewer1 for all .TIF files, Viewer2 for all .CAL files
and Viewer3 for all other files.

The table below illustrates how the applications in the above example ca
grouped into Tools and how they can be linked to file extensions.

There are three ways to start a Tool:
■ Select it from the Tools menu

Tool Extension Application

Viewers CAL VIEWER1.EXE
TIF VIEWER2.EXE
* VIEWER3.EXE

Convert @@@ CONVERT.EXE
Access @@@ MSACCESS.EXE



When a file in the 'Scanned files' area was selected, the application will start
and open that file.
■ Double click on a file in the 'Scanned files' area.
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This feature must be enabled in the 'Configure tools' window.
■ Select a file in the ‘Scanned files’ area and click the View button.

The application will start and open the selected file.
If a group of applications is selected, e.g. Viewers, which application will b
started, depends on the extension with which it is associated.

Three types of extensions can be used.
■ '@@@', for an application which must be started without a file,
■ the exact extension (e.g. TIF, CAL), for only files with that extension,
■ an asterisk (*), for any file.

Applications associated with '@@@' have the highest priority, then the
programs coupled to the exact extension and finally applications associa
with an asterisk.

▼ Defining a tool

1 From the Configure menu, choose Tools.
The Configure tools dialog box appears.

[7] Configure tools dialog box

2 In the New Menu Entry dialog box, type a descriptive name for a tool you w
to define, e.g. ‘View file’.

3 Choose the Add button.

3005-144



The Associations dialog box appears.
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[8] Associations dialog box

4 In the Extension box, type the extension of the scan files, e.g. ‘txt’, ‘hgl’, ‘t
etc.
You can use the wildcard character * for all the extensions which you do 
want to specify explicitly.
Note: You can also enter the extension @@@. You can use this option
start an application of your choice from within Scan Station, but not op
the selected file. This may be handy for applications which are not direc
related to a scan file, but which you frequently use in combination with
Scan Station, e.g. Microsoft Calculator.

5 In the Command Line box, type the name of the program file, including th
path and extension.
For example, to add Microsoft Notepad, located in the directory named
C:\WINDOWS, type c:\windows\notepad.exe.
If you don’t know the name of the program file, choose the Browse button
display a list of files and directories. Select the appropriate filename from
list, and then choose the OK button.

6 In the Arguments box, define the necessary arguments. Arguments are fi
parameters that are used when the application starts. If you need to spec
arguments, this information is supplied with the tool.

7 Click Add in the Associations dialog box.
8 Repeat steps 4 to 7 to make all the necessary associations.

You can make as many associations as you want. For example, you may
a number of viewing applications at your disposal, each of which can be u
to view specific file types. You may then want to use the tool Viewers in
different ways, depending on the extension of the selected file, e.g. start 
application to view TIFF files (*.tif) and start another application to view
HP-GL (*.hpg) files.

9 Click OK in the Associations dialog box.
10 Repeat steps 2 to 9 to define all the tools of your choice.

You can define up to 10 tools.



11 Arrange the defined tools in the order of your choice by selecting a tool in the
Menu Contents box and then clicking the Up or Down button. The first tool,
i.e. the tool which appears on top of the list, is the default tool. This tool will
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also be displayed as such in the Tools menu.
12 If necessary, select the option Double click on filename = start first tool.

This option means that, if you double click a file in the file list, the first
(default) tool will start and open the selected file automatically.

13 Click OK in the Configure Tools dialog box.

▼ Starting a tool

1 Select a file in the file list (the scanned files area).
2 From the Tools menu, choose a tool.

If you want to start the default tool, you can also either press the View bu
or double click the selected file (the latter only if this option is enabled in 
Configure Tools window).
The associated application is started from within Scan Station.

▼ Changing or deleting a file association

1 From the Configure menu, choose Tools.
2 Select the tool in the Menu Contents box for which you want to change the

association.
3 Choose the Associate button.

The Associations dialog box appears.
4 In the Extension box, type the extension which you want to delete or asso

with a different application.
The name of the existing associated application, if any, appears in the
Command Line box.

5 In the Command line box, delete the name of the program file.
You now have the following options:
■ If you just want to delete the file association, proceed with step 8.
■ If you want to create a new association, proceed with step 6.

6 In the Command line box, type the name, path and extension of the new
program file. If you do not know the name of the program file, choose the
Browse button to display a list of files and directories. Select the appropri
filename from the list, and then choose the OK button.

7 In the Arguments box, define the necessary arguments, fixed parameters
are used when the application starts.
If, for example, you want to update the file C:\data\scans.mdb with MS Acc
enter the filename in the Arguments box.

8 Click OK in the Associations dialog box.
9 Click OK in the Configure Tools dialog box.



▼ Deleting a tool

1 From the Configure menu, choose Tools.
2 Select the tool in the Menu contents list box.
Getting started 27

3 Click Delete.
4 Click OK.



Quitting Scan Station
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You can quit Scan Station by selecting Exit from the File menu or Close fr
the system menu. Normally you have to click the Stop button first and wait
all scanned files to be saved to disk.

▼ Quit Scan Station and save all scans

1 Click the Stop button.
Wait until the last scan is received.

2 From the system menu select Close or from the File menu select Exit.

▼ Quit Scan Station immediately

3 From the system menu select Close or from the File menu select Exit.
You are asked if scans in progress must be deleted or saved. Select ‘delet
quit immediately.

Note: When Scan Station stops, Machine Monitor on the same PC will rem
active. You have to explicitly quit this application.
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On-line help for Scan Station is a quick and convenient way to look up
information about a task you are performing, a feature you would like to kn
more about, or a command you want to use.

Help is available whenever you see a Help command button, or help as an
on the menu bar. When you select help from the menu, the first page of S
Station Help appears.

▼ Using the Help menu

1 From the Help menu choose Contents.

You can also press F1 at any time for help information. For menus, the St
bar at the bottom of the window also displays a one-line text to explain th
purpose of the currently selected menu item.
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Chapter 3

Using Scan Station

How to use all functions of the main window. Where to
store the images and accounting information for this scan
job. Settings on the scanner and the actual scanning
process.
31



The scanning process
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Note: Make sure Scan Station and Machine Monitor are started up and
connected.

Scanning requires that settings are selected on both Scan Station and th
scanner.

This chapter describes all settings that can be made on Scan Station and
settings you have to make on the scanner.

Scan Station supports the concept of scan jobs, sets of scans that belong
together because they share:
■ user and account name
■ destination, the drive and directory where the scans are stored
■ the file naming procedure.

A scan job cannot be interrupted by other jobs on the printer. The printer m
be released to process print or copy jobs explicitly by stopping the scann
process in Scan Station.



Scan Station Main window
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In this section the items in the main window will be explained.

[9] Scan Station main window

The central part of the Scan Station main window is called ‘Scanned files
This window lists the files created during this session of Scan Station. Fil
that were uploaded during a previous session, or files that have scrolled o
the list are not displayed anymore. Use the File Manager to handle these 
Each line denotes:
■ Status of the file. The status can be R or A.

R = ready, the scan data has been completely written to the file
A = active, the information is still arriving.

■ Name of the file
■ Size of the file (in kilo bytes)
■ Resolution (in dots per inch)
■ Width of the file/image (in pixels, mm or inches as set in preferences).
■ Length of the file/image (in pixels, mm or inches as set in preferences).

3008-144



Note: See ‘Defining Preferences’ on page 22.
■ User ID
■ Account ID
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The Delete button is to remove the selected file from the list of scanned file
and from the disk.

The View button is to display the selected file in the viewer. Click the View
button to start the view tool for the selected file.

The Start button is to start the scan process and claim the connection to th
scanner. When you use the Start button the first time and you did not use
New button, the New scan job window will automatically open (see ‘Job
settings’ on page 37).

The Stop button is to stop or finish the current scan job. This releases the
device for printing or copying. You can click Start to scan again. When no
scans are made during a certain period of time set in preferences (e.g. 13
minutes), Scan Station automatically stops the scan job (see ‘Defining
Preferences’ on page 22).

The New button will start a new scan job. The New scan job window will b
opened (see ‘Job settings’ on page 37).



Resolution and File format
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In the Settings area of Scan Station’s main window you can set the:
■ resolution
■ file format

▼ Set the resolution

1 Select the resolution at which the originals are to be scanned.
This setting applies to the next original that is scanned.

[10] Resolutions supported by the scanner

2 Select Check plot on or off.
When selected, a paper copy will be made while the original is being scan
Note: Putting Check plot on or off will automatically select “scan with copy
or “scan without copy” on the user interface of the scanner.

▼ Set the file format

1 Select the format in which the scanned files are to be saved. You can cho
either CALS or TIFF.

CALS type 1 is a raster file format, for which no additional parameters nee
be specified.

TIFF is a raster file format, for which additional settings can be specified.

[11] Selecting the file format

3009-144

3010-144



2 Press More to define TIFF settings.

30011
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[12] TIFF settings

3 Select file organisation raw, stripped or tiled.
4 Select compression method group 4, group 3 - 1D or None (untiled,

unstripped).
5 Press OK.

These settings apply to the next original that is scanned.

Note: Use compression ‘None’ when scanning (large) photos in photo
mode.



Job settings
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The New scan job window will appear when:
■ the Start button is pressed for the first time after Scan Station was starte
■ after pressing the New button in Scan Station's main window.

[13] New scan job window

Enter the following information in this window:
■ user and account name for the scan job,
■ user and account name for the plot job (in case the job is also printed),
■ the directory in which scanned files will be saved,
■ the naming of the files as they will be stored on your hard disk or netwo

disk.

Note: To define users and accounts (see ‘Defining a list of users and accou
on page 20).

User and account names User and account names are used to identify the
initiator of a scan job. They are displayed in the Scan Station Main windo
during scanning, and can be used for statistical purposes.

3012-144



Scan Station keeps a record of all jobs it has submitted. For each job the same
information as shown in the Scan Station main window is added to the log file.
This file is called scan.log and can be found in the directory where the Océ
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software resides. The log file is a text file, which can be read with any (ASC
editor.

The numbers linked to user and account name are used in the log file.

▼ Selecting user and account name for scan job

1 Select the checkbox of the ‘Scan’ User and Account field
Note: If this box is not selected, the default user and account name of t
copier is used.

2 Select the user name in the user list box.
3 Select the account name in the account list box.

Note: The numeric IDs are shown automatically.

▼ Selecting user and account name for print job (check plot)

1 Select the check box of the ‘Checkplot’ User and Account field.
Note: If this box is not selected, the default user and account name of t
copier is used.

2 Select the user name in the user list box.
3 Select the account name in the account list box.

Note: The numeric IDs are shown automatically.

▼ Specifying the directory for scanned files

Files can be stored in a directory on a disk which is accessible from the S
Station PC.

1 Type the path or click Browse to select the drive and directory where you w
your scans to be saved.

To specify the file names, select one of the three options:

■ Prompt for filename
Scan Station asks for a filename the moment it needs to store the data 
the scanner. It does so for every scan. If you omit the extension in this fi
name, it is automatically added by Scan Station. The extension as spec
in Preferences is used.

■ Fixed filename, variable suffix
The filename is fixed for all scans, but the suffix (extension) is numeric a
is incremented with every scan. Specify a filename, e.g. “project”, the
starting number, e.g. “1”, and the number of digits for the suffix, e.g. “3”



In this example a job of three pages will result in files called “project.001”,
“project.002” and “project.003”

■ Filename with variable part
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The filenames for all scans of the job consist of a fixed part and a nume
variable part. The variable part is denoted by three #-signs, placed anyw
in the filename. By specifying “proj###.tif” and a starting value of “100”, 
job of three pages will result in files called “proj100.tif”, “proj101.tif” and
“proj102.tif”. If you omit the extension in this file name, it is automaticall
added by Scan Station. The extension as specified in Preferences is us

▼ Specifying filenames for scans

1 Select the required file naming method.
2 If applicable, enter the file name, the starting value and the number of dig
3 Click OK if you want to make the current settings active. Select Cancel if y

do not want to change the settings.

Now make the required settings on the scanner operator panel.



Scanner settings on the Océ 9800
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If you are using an Océ 9800 scanner, a number of scanner options will
influence the result of the scanned image.

It is recommended not to use the settings in the ‘Image’ card of the ‘Copy
menu. These settings will only influence the printed copy (if ‘with copy’ is
selected), not the scanned image. This would result in a difference betwe
printed copy and scanned image.

Modifying the exposure

The automatic exposure control will provide a good quality copy from a la
variety of originals. The automatic exposure setting, which is switched on 
default), ensures the production of background-free copies of most line
drawings (see figure 14).

[14] Automatic exposure setting

▼ Setting the automatic exposure

1 Open the ‘Special original’ card in the ‘Copy’ section.
If the function ‘Automatic exposure’ is shown as in figure 14 above, then 
automatic exposure has been activated already.

2 If ‘Automatic exposure’ is deactivated press the function button ‘Automati
exposure’.
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When scanning extremely light or dark originals, or originals with unequal
background density such as paste ups, the result may not meet your
requirements (e.g. too much background). In such cases you can manually
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adjust the exposure.

▼ Manually adjusting the exposure setting

1 Press the ‘lighter or darker’ button on the scanner operator panel to set th
exposure as desired.

[15] Lighter/Darker buttons on the Océ 9800

The Océ 9800 allows you to adjust the exposure according to the type of im
on the original. There are four original types available. Select a suitable m
according to the original (see figure 16).

[16] Selecting the original type

▼ Adjusting the exposure according the type of image

1 Open the “Special original’ card in the ‘Copy’ section. By default ‘Normal’
and ‘Automatic exposure’ are active. When the original contains characte
and line works this is the most suitable setting.
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■ Press the function button ‘Original type’ to select ‘Photo’ when the original
consists of a combination of characters, line art and picture images.
Note: If you select ‘Photo’, the ‘Automatic exposure’ will default be
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switched off automatically.
■ Press the function button ‘Original type’ to select ‘Dark’ when the origin

has an extremely dark background (i.e. low contrast).
■ Press the function button ‘Original type’ to select ‘Blueprint’ when you wa

to copy an original with an image in ‘negative’ (image in white on dark
background). The copy will be ‘positive’ (image in black on white
background).

■ Press the function button ‘Original type’ to select ‘Cut&paste’ when the
original contains paste ups (‘cut and paste’ with scissors and glue).

Using file size optimization

The option for optimizing the file size will decrease the amount of data tha
used to store the scanned file. In this way you can store more images on
disk.

Note: If the original contains photographic images, this option must not be
used.

▼ Activating file size optimization

1 Open the ‘Special original’ card in the ‘Copy’ section.
If the function ‘Filesize optimization’ is shown as in figure 17 (black
background), then the automatic exposure has been activated already.

[17] Selecting Filesize optimization

2 If ‘Filesize optimization’ is deactivated, press the function button.
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Scanning non-standard size originals

The scanner of the Océ 9800 automatically detects the width of the inserted
A0,
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original. For European sizes, for example, it detects whether the width is 
A1, A2, A3, A4, 500 mm, or 700 mm (or 707 mm, depending on the
configuration). The Scan Station system uses a memory table that contain
standard width - standard length combinations to predict the length of the
original. The scanner also measures the real length of each original while
transferred through the scanner.

Note: If you are copying thick originals or originals in a carrier sheet, it is
recommended to use the output at the rear side of the scanner to ensure co
delivery.

Depending on the original, you must define both the original size and the
original length as specified below:

■ Standard original:

■ Standard width, non-standard length:

■ Non-standard width, non-standard length

Note: The original length is automatically set by the scanner for option 1.

Note: Selecting non standard original width (option 1) may cause some wh
space along your image. To prevent this, you can specify the exact width
yourself (option 2).

Note: If your scanner is equipped with 5 sensors instead of 8 sensors, it can
discriminate between 700mm, A0 and 36”. In that case always specify th
original width yourself (option2) to scan a 700mm or A0 original.

Original width Standard
Original length Standard

Original width Standard
Original length Automatic

Option 1 Option 2
Original width Non-standard Custom
Original length - Automatic or Custom



▼ Defining the original width and length

1 Open the ‘Special original’ card in the ‘Copy’ section.

 The
on

er

er

anner

ll

Ready to copy
................ ...............................Copies: ................
44 Océ Scan Station User Manual

[18] Defining the original size

2 Press ‘Original width’ to select the required setting:
■ Standard. This option must be used to copy a standard-size original.
■ Non-standard. This option can be used to copy a non-standard original.

scanned width will be larger than the original width, to prevent informati
loss.

■ Custom. You can define the original width yourself, using the higher/low
buttons or the numeric buttons.

3 If you have selected astandard width, you can define the original length by
pressing the appropriate button:
■ Standard. The scanner will use a standard original length.
■ Automatic. The original length will be measured by the scanner. Or,

4 If you have selected anon-standard width, the original length is automatically
measured by the scanner. You cannot change the original length setting
yourself. Or,

5 If you have specified the original width yourself (custom), you can also define
the original length by pressing the appropriate button:
■ Automatic. The original length will be measured by the scanner.
■ Custom. You can define the original length yourself, using the higher/low

buttons or the numeric buttons.

Using the zoom settings

You can use the zoom settings on the Océ 9800 operator panel of the sc
to enlarge the scanned image.

Note: The use of reduction in combination with scan-to-file functionality wi
not result is a reduced image. However, the print copyis reduced.
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▼ Enlarging when scanning a standard size original

1 Press one of the zoom step buttons on the operator panel, just below the zoom
display, to change the zoom factor for your original by standard steps (A4 to

ou
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A3, A3 to A2, etc). This will result in a standard size scanned image.
Note: If you want to change your zoom factor by non-standard steps, y
have to use the custom width and custom length settings.

Scanning originals with filing strip

You can adjust the original guide of the scanner to remove or add a filing s
along the left hand side (in the feed direction, face-up). The left hand side
be extended up to 20 mm or shortened up to 60 mm ().

[19] Example of adjusting the left hand side of an original

▼ Scanning with removed or added filing strip along the left hand side

1 If you want to remove a filing strip, move the original guide to the left.
2 If you want to add a strip, move the original guide to the right.

Left hand side
- 40 mm

Left hand side
+20 mm
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[20] Adjusting the original guide to add or remove a filing strip along the left hand side

3 Make all required settings.
4 Insert the original face up, left aligned along with the original guide on the

scanner feed table.
Note: The standard position of the original guide is marked on the copy fe
table. If you move the original guide to the standard position it will click in
place.

You can also remove the filing strip along the right hand side (in the feed
direction, face-up) by selecting a specific roll. If the paper width of the origin
is larger than the paper width of the selected roll, the remaining paper pa
the right hand side will not be scanned (see figure 21).

[21] Example of removing the right hand side of an original

▼ Scanning with removed filing strip along the right hand side

1 Select one of the roll selection buttons on the operating panel.
2 Select the 100% button.
3 Make sure the ‘auto zoom’ and ‘auto roll’ buttons are not selected.

Paper width on
selected roll
-20 mm

Right hand side
-20mm



4 Make other settings as required.
5 Feed the original.

It is also possible to adjust the length of the leading edge to eliminate a filing
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strip. The leading edge can be shortened up to 100 millimetres.

▼ Scanning with removed filing strip along the leading edge

1 Open the ‘Copy size’ card in the ‘Copy’ section.
2 Press the function button ‘Remove strip’ twice (see figure 22).

[22] Removing strip

3 Adjust the values in millimetres for the leading edge using the numeric or
higher/lower buttons.

Scanning with removed filing strip along the trailing edge If you want to
remove thetrailing  edge, you can use the ‘Remove strip’ setting for the
leading edge as described above, and feed the original with the trailing e
first. Then use the Océ Viewer to rotate the scanned image 180˚.

Note: You can also define the original width and length.
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If you are using an Océ 9700 scanner, a number of scanner options will
influence the result of the scanned image.

It is recommended not to use the settings in the ‘Image’ card of the ‘Copy
menu. These settings will only influence the printed copy (if ‘with copy’ is
selected), not the scanned image. This would result in a difference betwe
printed copy and scanned image.

Modifying the exposure

The automatic exposure control will provide a good quality copy from a la
variety of originals. The automatic exposure setting, which is switched on 
default), ensures the production of background-free copies of most line
drawings (see figure 23).

[23] Automatic exposure setting

▼ Setting the automatic exposure

1 Open the ‘Special original’ card in the ‘Copy’ section.
If the function ‘Automatic exposure’ is shown as in figure 14 above, then 
automatic exposure has been activated already.

2 If ‘Automatic exposure’ is deactivated press the function button ‘Automati
exposure’.
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When scanning extremely light or dark originals, or originals with unequal
background density such as paste ups, the result may not meet your
requirements (e.g. too much background). In such cases you can manually
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adjust the exposure.

▼ Manually adjusting the exposure setting

1 Press the ‘Exposure’ button on the main window of the operator panel, and
the higher/lower buttons to change the exposure.

[24] Modifying the exposure on the Océ 9800

The Océ 9700 allows you to adjust the exposure according to the type of im
on the original. There are five original types available. Select a suitable m
according to the original (see figure 25).

[25] Selecting the original type

▼ Adjusting the exposure according to the type of image

1 Open the “Special original’ card in the ‘Copy’ section. By default ‘Normal’
and ‘Automatic exposure’ are active. When the original contains characte
and line works this is the most suitable setting.
■ Press the function button ‘Original type’ to select ‘Photo’ when the origin

consists of a combination of characters, line art and picture images.
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Note: If you select ‘Photo’, the ‘Automatic exposure’ will default be
switched off automatically.

■ Press the function button ‘Original type’ to select ‘Dark’ when the original

nt

t is
 your
50 Océ Scan Station User Manual

has an extremely dark background (i.e. low contrast).
■ Press the function button ‘Original type’ to select ‘Blueprint’ when you wa

to copy an original with an image in ‘negative’ (image in white on dark
background). The copy will be ‘positive’ (image in black on white
background).

■ Press the function button ‘Original type’ to select ‘Cut&paste’ when the
original contains paste ups (‘cut and paste’ with scissors and glue).

Using file size optimization

The option for optimizing the file size will decrease the amount of data tha
used to store the scanned file. In this way you can store more images on
disk.

▼ Selecting file size optimization

1 Open the ‘Special original’ card in the ‘Copy’ section.
If the function ‘Filesize optimization’ is shown as in figure 17 (black
background), then the file size optimisation has been activated already.

[26] Selecting Filesize optimization

2 If ‘Filesize optimization’ is deactivated, press the function button.
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Scanning non-standard size originals

The scanner of the Océ 9700 automatically detects the width of the inserted
A0,
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original. For European sizes, for example, it detects whether the width is 
A1, A2, A3, A4, 500 mm, or 700 mm. The Scan Station system uses a mem
table that contains all standard width - standard length combinations to pre
the length of the original. The scanner also measures the real length of e
original while it is transferred through the scanner.

Note: If you are copying thick originals or originals in a carrier sheet, it is
recommended to use the output at the rear side of the scanner to ensure co
delivery.

Depending on the original, you must define both the original size and the
original length as specified below:

■ Standard original:

■ Standard width, non-standard length:

■ Non-standard width, non-standard length

Note: For option 1, the original length is automatically set by the scanner.

Note: Selecting non standard original width (option 1) may cause some wh
space along your image. To prevent this, you can specify the exact width
yourself (option 2).

Original width Standard
Original length Standard

Original width Standard
Original length Automatic

Option 1 Option 2
Original width Non-standard Custom
Original length - Automatic or Custom



▼ Defining the original width and length

1 Open the ‘Special original’ card in the ‘Copy’ section.
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[27] Defining the original size

2 Press ‘Original width’ to select the required setting:
■ Standard. This option must be used to copy a standard-size original.
■ Non-standard. This option can be used to copy a non-standard original.

scanned width will be larger than the original width, to prevent informati
loss.

■ Custom. You can define the original width yourself, using the higher/low
buttons or the numeric buttons.

3 If you have selected astandard width, you can define the original length by
pressing the appropriate button:
■ Standard. The scanner will use a standard original length.
■ Automatic. The original length will be measured by the scanner.

Or,
4 If you have selected anon-standard width, the original length is automatically

measured by the scanner. You cannot change the original length setting
yourself. Or,

5 If you have specified the original width yourself (custom), you can also defi
the original length by pressing the according button:
■ Automatic. The original length will be measured by the scanner.
■ Custom. You can define the original length yourself, using the higher/low

buttons or the numeric buttons.

Using the zoom settings

You can use the ’Zoom selection’ function button on the Océ 9700 operat
panel to enlarge the scanned image.

Note: The use of reduction in combination with scan-to-file functionality wi
not result is a reduced image. However, the print copyis reduced.
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▼ Enlarging when scanning a standard size original

1 Use the ‘Zoom selection’ function button to select the zoom function.
2 Use the higher button at the right of the display to increase the zoom factor.
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Note: If you hold down the higher button, the zoom factor will scroll up o
down fast, with a pause when a fixed zoom step is reached. These fix
zoom steps can be specified by the key operator.

Note: If you want to change your zoom factor by non-standard steps, y
have to use the custom width and custom length settings.

Scanning originals with filing strip

You can adjust the original guide of the scanner to remove a filing strip al
the left hand side (right hand side in the feed direction, face-down). This s
can be shortened up to 60 mm (see figure 28).

[28] Example of adjusting the left hand side of an original

Face up:
Left hand side
- 40 mm

Face down:
right hand side
in feed direction



▼ Scanning with removed filing strip along the left hand side (right hand side
in the feed direction, face-down)

1 Press the catch underneath the original guide, and move it to the right.
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[29] Adjusting the original guide to add or remove a filing strip along the left hand side

2 Make all required settings.
3 Insert the original face down, right aligned along with the original guide on 

scanner feed table.

You can also remove the filing strip along the right hand side (left hand sid
the feed direction, face-down) by selecting a specific roll. If the paper width
the original is larger than the paper width of the selected roll, the remainin
paper part on the right hand side will not be scanned (see figure 30).

[30] Example of removing the right hand side of an original

▼ Scanning with removed filing strip along the right hand side (left hand side
in the feed direction, face-down)

1 Select one of the roll selection buttons on the operating panel.
2 Select the 100% button.

Face up:
Right hand side
- 40 mm

Face down:
left hand side in
feed direction



3 Make sure the ‘auto zoom’ and ‘auto roll’ buttons are not selected.
4 Make other settings as required.
5 Feed the original.
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It is also possible to adjust the length of the leading edge to eliminate a fi
strip. The leading edge can be shortened up to 100 millimetres.

▼ Scanning with removed filing strip along the leading edge

1 Open the ‘Copy size’ card in the ‘Copy’ section.
2 Press the function button ‘Remove strip’ twice (see figure 31).

[31] Removing strip

3 Adjust the values in millimetres for the leading edge using the numeric or
higher/lower buttons.

Scanning with removed filing strip along the trailing edge If you want to
remove thetrailing  edge, you can use the ‘Remove strip’ setting for the
leading edge as described above, and feed the original with the trailing e
first. Then use the Océ Viewer to rotate the scanned image 180˚.

Note: You can also define the original width and length.
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During the scanning process, you do not have to go back to the Scan Sta
PC, unless you need to make changes to the settings. The productive co
will show to its full advantage when a large number of originals are scanne
one 'batch'. The scanner can then be used at full speed and all images a
automatically written to separate files on the disk.

You can also change the settings any time you want between scans. The
settings apply to the next original that you feed to the scanner.

▼ Scanning one or more originals

1 Start-up the Océ Scan Station
2 On the Scan Station, make the required settings and press the ‘Start’ butto

the main window.
3 Press the ‘Scan’ button on the main window of the scanner operator pane

define if you want to send the scanned file to the printer:
■ with copy: the scanned original will be printed and it will also be saved in

file by the Scan Station.
■ without copy: the scanned original will only be saved in a file by Scan

Station
4 Make all required scanning settings on the operator panel of the scanner
5 If you have selected ‘with copy’, also make the required print settings on 

operator panel of the scanner, e.g. finishing settings.
6 Feed the original into the scanner.
7 Press the start button on the scanner operator panel.

The original is scanned and, if selected, printed on paper. At the same tim
is sent to the Scan Station to be stored on disk. Each scan appears as one
in the ‘Scanned files’ list in the main window. Using the viewer, you can s
the scanned image on the screen of the Scan Station.

8 Repeat step 2 to 7 for each original you want to scan. If you have enable
‘automatic feed’ on the scanner, originals can be fed without pressing the
‘Start’ button on the scanner operator panel, after the first original.

9 The scan process can be stopped by pressing the ‘Stop’ button on the Sc
Station main window, or by quitting the application.
The Océ engine is now free for printing and copying.



Using Scan Tickets
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Scan Tickets can be used to connect your EDM application to Scan Statio
Scan Ticket contains information about which drawing you want to scan, 
what scan settings should be used.

Note: You will need additional software to enable your EDM application to
generate the required Scan Tickets and start up Scan Station automatica
(see Océ Job Ticket Interface Programmer’s Manual for more information

In this way it is possible to feed the EDM application with all the reference
(META data) of the drawings you want to scan, and let the EDM system s
up Scan Station, using the required Scan Tickets.

[32] Using Scan Tickets

Start up
&

Scan
Ticket

Scan
Station

Machine
Monitor

Scanner
Printer

EDM
application

Scanned
 file
&

Info file



A Scan Ticket contains information about each drawing that is to be scanned:

■ Original identification, e.g. name or codenumber
■ Original size and orientation (only valid in a scan ticket for the Océ 9400)
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■ Resolution
■ File Format
■ Check Plot (yes/no)
■ Name and directory to store the scanned file
■ Name and direcory to store the info file
■ Account and user name

If Scan Station is started up to process a Scan Ticket, the settings for eac
drawing will be read from the Scan Ticket and activated in Scan Station
automatically.

The Scan Jobs Settings window will show the operator which drawing is to
scanned. The operator can feed the original into the scanner.

After scanning, the scanned file will be saved automatically, using the nam
and directory as specified in the Scan Ticket. Also an info file can be crea
containing logging data of the scan. It will be saved, using the name and
directory as specified in the Scan Ticket.

▼ Using Scan Tickets

1 Use the EDM application to start up Scan Station to process a Scan Tick
2 The Scan Job Settings window will be opened. This window shows

information about the drawing that is to be scanned (see figure 33 on page
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[33] Scan Job Settings window

3 In the upper right corner of the Scan Job Settings window two numbers a
displayed. For example, 1::5 means: First drawing of a total of five drawin
to be scanned.

4 If you decide not to scan the requested drawing, click the Skip button in t
main window. If the Scan Ticket contains more drawings to scan, the nex
drawing will appear in the Scan Job Settings window. Otherwise the scan
will be ended.

2816-144
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[34] Main window after starting up to process a Scan Ticket

5 If required, you can make additional settings (e.g lighter/darker) on the
operating panel of the scanner (see ‘Scanner settings on the Océ 9800’ o
page 40. or ‘Scanner settings on the Océ 9700’ on page 48)

6 Feed the required original into the scanner.
7 Repeat step 2 to 7 until all drawings as specified in the Scan Ticket are sca
8 After scanning all drawings, the Behaviour of Scan Station depends on h

the EDM application started Scan Station:
■ Scan Station will return to is normal mode. You can use Scan Station fo

manual scan jobs.
■ Scan Station will be terminated.

▼ Interrupting a Scan Ticket Job

1 If you want to stop the scan process before reaching the end of the Scan T
click the Stop button on the main screen. The Scan Ticket will be kept on 
to resume the scan job later on.

▼ Resuming an interrupted Scan Ticket job

1 Use the EDM application to start up Scan Station to process the Scan Tick
the interrupted scan job. The following window will appear:
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[35] Selecting to proceed where you left or to start at the beginning of the Scan Ticket.

2 Click Yes if you want to resume the interrupted scan job where you left. If y
want to start at the beginning of the interrupted job, click No.

3 If you decided to resume the interrupted scan job where you left, the follow
window will appear:

[36] Selecting to redo the scanning of the last drawing you scanned.

4 If you want to redo the scanning of the last drawing you scanned, click Ye
you want to scan the next drawing, click No.

5 The scanning will proceed.

2384-144
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Notation conventions
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There are a number of notation conventions used in this manual. This
consistent style enables you to quickly become conversant with the use o
manual and consequently the Scan Station.

Description Each section or subsection contains a description of the featur
operation identified in the title. It might also include possible applications,
well as any guidelines that you should bear in mind.

Procedures A description is followed by a procedure. A procedure always
begins with a phrase which briefly describes the procedure (for example,
Loading paper:) followed by a series of numbered steps that take you, ste
step, through all phases of performing the operation.

Figures and tables Figures and tables are titled and numbered sequentiall
throughout this manual. Figures include pictures of product components,
examples, and diagrams of concepts discussed in the description.

Attention getters There are several types of information to which we draw
your attention. This information is classified as follows:

Note: In a ‘Note’, information is given about matters which ensure the prop
functioning of the copier, but useful advice concerning its operation may a
be given.

Attention: The information that follows ‘Attention’ is given to prevent
something (your copy or original, the copier, etc.) being damaged.

Caution: The information that follows ‘Caution’ is given to prevent you
suffering personal injury.



Reader’s comment sheet
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Have you found this manual to be accurate?
❏ Yes
❏ No

Could you operate the product after reading this manual?
❏ Yes
❏ No

Does this manual provide enough background information?
❏ Yes
❏ No

Is the format of this manual convenient in size, readability and arrangeme
(page layout, chapter order, etc.)?
❏ Yes
❏ No

Could you find the information you were looking for?
❏ Always
❏ Most of the times
❏ Sometimes
❏ Not at all

What did you use to find the required information?
❏ Table of contents
❏ Index

Are you satisfied with this manual?
❏ Yes
❏ No

Thank you for evaluating this manual.
If you have other comments or concerns, please explain or suggest
improvements overleaf or on a separate sheet.

7056139
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--------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------

Date:

This reader’s comment sheet is completed by:
(If you prefer to remain unknown, please do fill in your occupation)

Name:

Occupation:

Company:

Phone:

Address:

City:

Country:

Please return this sheet to:

Océ-Technologies B.V.
For the attention of ITC user documentation.
P.O. Box 101,
5900 MA Venlo
The Netherlands



Addresses of local Océ organisations
Océ-Australia Ltd.
P.O.Box 196
Cheltenham VIC 3192

Océ-France S.A.
32, Avenue du Pavé Neuf,
93882 Noisy-le-grand
Australia Cedex
Miscellaneous

Océ-Österreich GesmbH
Postfach 95
1233 Vienna
Austria

Océ-Belgium N.V./S.A.
Avenue J.Bordet 32
1140 Brussels
Belgium

Océ-Brasil Comércio e Industria Ltda.
Caixa Postal 3187
01060-970 Sao Paulo, SP
Brazil

Océ-Canada Inc.
525, Logan Avenue,
Toronto, Ontario M4K 3B3
Canada

Océ Office Equipment (Beijing) Co Ltd.
Xu Mu Cheng
Chaoyang District
Beijing 100028
China

Océ-âeská republika s.r.o.
K Ry‰ánce 16
14754 Praha 4
Czech Republic

Océ-Danmark A.S.
Kornmarksvej 6
2605 Brondby
Denmark
67

France

Océ-Deutschland GmbH
Postfach 101454
45481 Mülheim an der Ruhr
Deutschland

Océ (Hong Kong China) ltd.
Post Box 30971
Causeway Bay Post Office
Hong Kong

Océ-Hungária Kft.
P.O.B. 237
1244 Budapest
Hungary

Océ-Italia S.p.A.
Casella Postale
10.230 Milano
Italia

Océ Systems (Malaysia Sdn. Bhd.
#3.01, Level 3, Wisma Academy
Lot 4A, Jalan 19/1
46300 Petalig Jaya
Selangor Darul Ehsan
Malaysia

Océ-Nederland B.V.
P.O.Box 800
5201 AV Den Bosch
The Netherlands
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Océ Norge A/S
Postboks 53, Grefsen
0409 Oslo
Norway

Océ-Poland Ltd.
Lopuszanska 53
02-232 Warszawa
Poland

Océ-Lima Mayer S.A.
Avenue Infante D.Henrique
Lote 309 - Cabo Ruivo
1900 Lisboa
Portugal

Océ (Far East) Pte. Ltd./
Océ (Singapore) Pte. Ltd.,
1 Clementi Loop
#02-10 Margateo Districentre
Clementi West Distripark
Singapore 129808

Océ España SA
Business Park MAS BLAU
Osona 2
08820 El Prat del Llobregat (Barcelona)
Spain

Océ-Schweiz AG
Postfach 114
CH-8152 Glattbrugg
Switzerland

Océ-Svenska AB
P.O.box 1231
164 28 Kista
Sweden

Océ (Taiwan) Ltd.
No. 99-24 Nan-Kang Road
Sec 2
Taipei
Taiwan, ROC

Océ (Thailand) Ltd.
16th Floor, B.B. Building
54 Asoke Road, Sukhumvit 21
Bangkok 10110
Thailand

Océ-U.K.Ltd.
Langston Road
Loughton Essex IG10 3SL
United Kingdom

Océ-USA Inc.
5450 North Cumberland Av.
Chicago, Ill. 60656
U.S.A.
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